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Introducing CorelDRAW® Graphics Suite X8

CorelDRAW® Graphics Suite X8 is a comprehensive
graphics solution that helps you transform your creative
energy into artwork that will delight and create lasting
impressions across any medium. Its high-caliber tools,
unparalleled power, and highly customizable workspace
empower you to harness your creativity, design your way,
and inspire your audience.

Whether you are a new user or have lived and breathed
CorelDRAW for years, take advantage of a wide range of
learning tools and a customizable environment to get
started quickly and make the app uniquely your own. For
anyone creating graphics on Windows, CorelDRAW
Graphics Suite X8 is optimized to take full advantage of
the latest generation of Windows 10 devices. And with
an emphasis on productivity, CorelDRAW Graphics Suite X8
makes your workflow faster and simpler, all while giving
you more control — especially when working with fonts
or editing images and objects.

We welcome you to learn more about the power and
creative possibilities of the new CorelDRAW Graphics
Suite X8.

Jump in

One of the guiding principles in the development of
CorelDRAW Graphics Suite X8 was ensuring that nothing
ever impedes your creative confidence. With that in mind,

Reviewer's Guide [ 2 ]

versatile resources that aim to inspire and educate are built
right into the suite. Whether you're a first-time user, you're
upgrading from an earlier version or you have experience
with other graphics software, there are in-product learning
tools designed for you. Case in point, the new Startup
tours. This series of interactive tutorials reduces the
learning curve so you can get up and running faster than
ever before. What's more, the popular Hints docker has
been enhanced to make it even easier to maximize the
suite’s tools and features as you work. And now accessible
from the revamped Welcome Screen, the Discovery Center
offers a collection of creative tips and tutorials for every
learning style and skill level.

The technology that drives so much of the design world is
evolving at an astonishing rate. CorelDRAW Graphics Suite X8
is designed to let you fully leverage these advancements.
Whether it's the latest version of the world’s most popular
operating system, the most high-definition monitors, or
advanced multi-monitor support, you can design with
ease.

Craft

CorelDRAW Graphics Suite has long been the graphics
software of choice with creative and production
professionals because the unparalleled power of its
toolset allows them to design with dexterity, speed, and
confidence.



As much as CorelDRAW Graphics Suite hopes to inspire
you, that relationship is a two-way street. Many new
features were developed as a direct result of suggestions
from users who depend on the suite every day. This
invaluable feedback led to such workflow enhancements
as the Font list box, which simplifies locating the perfect
font for your project. New object-editing options — such
as the ability to hide objects, copy and reuse curve
segments, and select adjacent nodes —simplify and
accelerate even the most complex designs. The
enhanced Knife tool opens a world of creative
possibilities by letting you intuitively and precisely split
vector objects, text, and bitmaps. Corel® PHOTO-PAINT® X8
also rolls out a range of high-caliber photo-editing
additions, including the Healing Clone tool for
seamlessly removing blemishes from images, perspective
distortion corrections, and a new Gaussian Blur lens.

Personalize

For every industry that relies on CorelDRAW Graphics
Suite, there's a different workflow, each with different
needs. Rather than force anyone to work a certain way,
Corel encourages you to work in whatever way best suits
you and your projects.

You can adapt your design space by customizing icon
sizes or the color of the desktop and window borders.
You can choose from a variety of Ul arrangements
designed for specific tasks, Lite workspaces designed to
make each application’s most commonly used tools
more readily accessible, or classic X6 Inspired workspaces
for longtime users who may prefer the suite’s legacy

appearance. There are also a range of customization
options to help you tailor the interface to suit your
workflow. Because fonts are central to so many creative
sectors, the new Corel Font Manager” simplifies finding
and managing fonts on your system. You can also
enhance and tailor your workflow even more by
choosing from a collection of creative tools available for
download or purchase directly from within the suite.

Delight

CorelDRAW® Graphics Suite X8 has everything you need
to deliver eye-catching professional-quality designs to
any medium. Whether your work is destined for the
web, social media, print ads, brochures, billboards or
vinyl signs, the suite provides the flexibility and accuracy
that you need for all types of projects.

One of the reasons that CorelDRAW Graphics Suite has
long been a favorite with creative professionals is that it
has always allowed them to focus on wowing their
audience. Time spent tweaking color settings and
dealing with file formats comes at the expense of what
they'd really rather be doing — creating expressive,
captivating designs. To that end, CorelDRAW Graphics
Suite offers a color-management system that assures
accurate color representation regardless of your level of
expertise. Whether you're importing a client’s mock-up,
working with previous designs, or sending a project to a
print shop or manufacturing facility, you can be certain
that your colors are true. And with its industry-leading
file format compatibility, CorelDRAW Graphics Suite X8
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provides the flexibility that designers need for sharing
their work. There's also a web-development tool, Corel®
Website Creator”, that has dozens of templates so you
can easily design, build, and maintain a web presence
without having to learn how to code.

And when you could use some inspiration or advice,
there’s the CoreDRAW Community site. It's the place
where users can get together to share and learn from
others, discover what community members create, and
fuel their inspiration.

Choose your purchase option

In the interest of user choice, we're offering several
CorelDRAW Graphics Suite purchase options.

Perpetual License

At Corel, we strongly believe that you should not be
forced into a rental model if you don’t want it. For a
one-time payment, a CorelDRAW perpetual license gives
you the right to use the software forever, with no extra
monthly cost. By purchasing a box, download version or
volume license version of the product, you get access to
the full benefits of a specific version, and there is no
need for a permanent Internet connection. Perpetual
licenses give you the option to pay for future major
upgrades, only if you want them.

Subscription

A CorelDRAW® Subscription is an affordable way to stay
up-to-date with the latest tools and enhancements of
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CorelDRAW Graphics Suite. It offers a cost-effective
alternative to paying the upfront cost of the software.
Instead, you'll get a full, downloadable version of
CorelDRAW Graphics Suite” that remains entirely
functional for as long as your subscription is active. You
decide how and when you want to use it. An annual
plan offers an overall discount, with the option to auto-
renew or end your subscription after the 12-month
period.

You'll always be notified when the latest performance
enhancements, updates and versions are available for
download. Your subscription entitles you to the next
major version upgrade for as long as your subscription is
active.

Upgrade Program

The new CorelDRAW® Upgrade Program is the hassle-
free way for designers to keep their toolbox up-to-date
at the best price. If you own a version of CorelDRAW
Graphics Suite with a perpetual license, you pay one
affordable fee once a year, and you're assured of
working with the latest design tools, new file
compatibility, and the most current technology. And as
long as your account is active, you'll automatically get
the latest version of CorelDRAW Graphics Suite. Best of
all, sign up once and forget about it. In addition, if your
needs change, you will continue to own the last version
you received through the upgrade program.

“A corel.com account and Internet connection are required to
download and use the application and manage your subscription.
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Customer profiles

Graphics and creative professionals

Graphics and creative professionals in advertising and
printing industries spend much of their time creating
and editing graphics, working with text, and retouching
photos.

These users frequently work on layout and design
projects for print and the web, such as creating logos
and multipage brochures. They seek innovative design
tools that optimize their workflow and compatibility
with commonly used file formats.

Production professionals

These users focus primarily on sign making, screen
printing, engraving, and graphic design for print and the
web. They frequently repurpose and combine such assets
as illustrations, scanned logos, photos, clipart images,
and fonts. They often repurpose content provided by
clients in a variety of formats. They use this as a starting
point, but spend the bulk of their time reworking and
tweaking it. They pay particular attention to design
optimization and output preparation. Their work is
output to large-format printers, engraving machines,
glass or vinyl cutters, and silk-screen or Direct to
Garment (DTG) printers.
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Occasional graphics users

Entrepreneurs and small to medium-sized businesses
often create marketing and communications materials
in-house. Often self-taught in graphic design, these
occasional users modify existing artwork, retouch
photos, and create ads, flyers, and other marketing
collateral.

Business users in medium-sized to large enterprises strive
to create professional, graphically rich projects ranging
from sales presentations to web graphics. They spend
considerable time reworking existing projects and
retouching photos to use in their marketing and
communications materials.

Hobbyists are self-taught and use graphic design
software occasionally for creative projects — such as
newsletters, calendars, banners, and photo layouts —
for personal or community use.



Why do graphics professionals choose
CorelDRAW Graphic Suite?

There are many reasons why CorelDRAW Graphics Suite
is the software of choice in so many industries, but two
really stand out: unparalleled typographical features and
the ability to fine-tune your design environment with
customization options and the support for the latest
technology.

Typography

Whether your work is destined for the web, a digital
sign, a billboard or print, chances are text will be a
critical part of the design. Text is such an important
element of a design because it can truly set the tone of a
project. A font or text style chosen haphazardly can
undermine an otherwise great piece of work, running
counter to the rest of a design.

CorelDRAW Graphics Suite simplifies your typographic
workflow by allowing you to manage your font
collections and create new ones, choose the perfect font
for a project, refine the look of text until it's just right,
and ensure that there are no problems when handing off
a design for printing. CorelDRAW Graphics Suite X8
introduces Corel Font Manager, a standalone font
management application for finding, organizing, and
previewing local fonts. It also provides easy access to
online fonts on the Content Exchange. In addition to
existing typographical features that have made the suite
a favorite with graphics and production professionals,

enhanced searching and filtering features help you
find fonts for any project faster than ever.

The Insert Character docker helps you quickly find a
font’s available glyphs, while the Font Playground lets
you easily find the perfect font by comparing and
adjusting a variety of text examples. Font embedding
ensures that CorelDRAW documents can be viewed,
printed, and edited exactly as designed. You can also
access and preview advanced OpenType features for your
fonts, including strong support for Asian text.

Flexible Ul customization

When it comes to giving you the freedom to modify your
design environment to your exacting standards, few
applications come close to CorelDRAW Graphics Suite.
Giving you the ability to design in a personalized creative
environment has always been a hallmark of the suite.
There are endless customization options that let you
keep frequently used tools within easy reach and tailor
the main applications to work the way you prefer. Quick
Customize buttons make workspace customization fast
and easy. And icons have been redesigned, allowing
you to scale them up to 250%, so you can get more
out of high-resolution displays. You can also pick the
color of the desktop, toolbars, and window borders to
best suit your projects. What's more, CorelDRAW has a
variety of workflow-specific workspaces based on the
recommendations of professional industry experts who
use the suite routinely to arrange tools and features for
specific tasks.
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In this release, the suite has been optimized for high
resolution displays, ensuring that user interface
elements appear crisp and legible when displayed on
high resolution monitors, including UltraHD 4K.
Advanced multi-monitor support ensures that you can
work in CoreIDRAW and Corel PHOTO-PAINT across
multiple monitors of varying DPI.
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What's included?

Applications

CorelDRAW® X8: This intuitive vector-illustration
and page-layout application meets the demands of
today’s busy graphics professionals and graphics
non-professionals.

Corel® PHOTO-PAINT® X8: This professional
image-editing application lets you quickly and easily
retouch and enhance photos.

Corel Font Manager™ X8: This standalone font
management application lets you find, organize, and
preview local fonts, as well as online fonts on the
Content Exchange.

Corel® PowerTRACE® X8: This utility is embedded
in CorelDRAW to help you quickly and accurately
convert bitmaps into editable vector graphics.

Corel® CONNECT™ X8: This full-screen browser lets
you access the suite’s digital content, the new
Content Exchange, and search your computer or
local network to quickly find the perfect
complement for a project.

Corel CAPTURE"™ X8: This one-click utility lets you
capture images from your computer screen.

Corel® Website Creator™": This application offers
a fast and easy way to design, build, and manage
websites.
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Supporting applications

Barcode Wizard: This wizard guides you through
the generation of bar codes in a wide range of
industry-standard formats.

Duplexing Wizard: This wizard helps you optimize
your projects for two-sided printing.

PhotoZoom Pro 4": This plug-in lets registered users
export and enlarge digital images from Corel
PHOTO-PAINT.

WhatTheFont: This online font identification
service is integrated with CorelDRAW.

Microsoft® Visual Basic® for Applications 7.1:
This integrated development environment includes
64-bit support and helps you streamline your
workflow by automating tasks.

Microsoft® Visual Studio® Tools for Applications
2015: This toolset includes the power of the .NET
framework, so you can create time-saving macros to
automate tasks and extend functionality.

GPL Ghostscript: This feature lets you isolate and
use individual elements of imported EPS files rather
than only header images. It also improves the import
of PDF files generated by third-party applications.

*  Application download requires Internet connection and
an authenticated version of CorelDRAW Graphics Suite.



Content

* 10,000 high-quality clipart and digital images

e 2,000 professional, high-resolution digital photos
e 1,000 OpenType® fonts

e 350 professionally designed templates

e 2,000 vehicle templates

e Qver 1,000 fills, frames and patterns

Documentation

e Quick Start Guide
¢ Quick-reference card

* Help files

Training

*  New! Interactive Startup tours
*  New! Insights from the Experts
* Enhanced! Hints docker

e Enhanced! Discovery Center access from the
Welcome Screen

e Enhanced! More than 5 hours of training videos,
with new content

* Video Hints
* Tips & Tricks

Minimum system requirements

Windows 10, Windows 8.1, or Windows 7 (32-bit
or 64-bit editions), with latest updates and service
packs

Intel Core i3/5/7 or AMD Athlon 64
2 GB of RAM
1 GB of hard disk space

1280 x 720 screen resolution at 100% (96 dpi),
1920 x 1080 at 150%, and 2560 x 1440 at 200%

DVD drive for installation by disc
Multi-touch screen, mouse, or tablet
Microsoft .NET Framework 4.6
Microsoft Internet Explorer 11 or higher

Internet connection is required to activate and
validate CorelDRAW Graphics Suite, to receive
product updates, and use online product features
and content. The product can be used offline if you
connect to the Internet at least once a month to
validate your software license.
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Top new and enhanced features

CorelDRAW Graphics Suite X8 is an intuitive and
complete graphics solution that empowers you to make
a major impact with your artwork.

Jump in

With a variety of in-product learning resources, it's never
been easier for first-time users or experienced designers
to jump in and quickly get started with CorelDRAW
Graphics Suite. And with the ability to leverage the
power of Windows 10 and use the newest monitors, you
can take advantage of the latest technology to enrich
your projects.

New! Interactive Startup tours: You can get to work
faster and more efficiently thanks to a series of
interactive Startup tours. Whether you are new to
graphics software, an experienced user, or someone
familiar with other graphics applications, there's a start-
up tour to help you quickly get up to speed and take full
advantage of the features and tools of CorelDRAW
Graphics Suite X8.

You can learn the basics, see what's new,
or transition to the suite.
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Give it a try
Taking an interactive tour

Click the Welcome Screen tab.

If the Welcome Screen is not active, click Window

» Welcome Screen.

On the Getting Started page, click Tour New
Features in the Take a Tour area.

You can also launch this tour by clicking Help »
Take a Tour P Tour New Features.

This tour is designed for users who are familiar with
earlier versions of CoreIDRAW Graphics Suite. When
you start a tour, a sample drawing opens
automatically. The steps in the tour are directly
related to design elements in this file.

As you complete a stage of a tour, you can move to
the next step by clicking Okay!. You can also
navigate to a specific step in the tour by clicking the
step’s corresponding button at the bottom of the
tour window.

If you want to pause a tour, click Quit, and click
Yes in the dialog box that asks you if you want to
save the results. To resume the tour, click the tour
title, and click Continue Progress in the dialog
box that appears.



Enhanced! Hints docker: The Hints docker is a hub of
valuable learning resources designed to help reduce the
learning curve for new users. It dynamically displays
context-sensitive information on the currently selected
tool and provides links to related information. Enhanced
in CorelDRAW Graphics Suite X8, the Hints docker now
gives you quick access to additional resources such as
video hints, longer videos, and written tutorials, so you
can learn more about a tool or feature without having to
search.

The enhanced Hints docker makes it easier
than ever to get up and running quickly.

New! User guides available as eBooks: The
CorelDRAW X8 User Guide and Corel PHOTO-PAINT X8
User Guide are available as eBooks. Published to the
EPUB and MOBI file formats, the eBooks bring the most
comprehensive and up-to-date information about
product features to your eBook reader. Following the
user guides on an eBook reader saves you switching
between program windows on your system, allows you
to keep learning on the go, and ensures access to the

suite’s Help files when you don’t have Internet access. To
access an eBook, sign in to your corel.com account, and
click Downloads on Your Account page.

Enhanced! Discovery Center: The Welcome screen in
CorelDRAW and Corel PHOTO-PAINT gives you quick and
easy access to the Discovery Center. Aiming to inspire and
educate, the Discovery Center provides a wide variety of
creative tips and tutorials designed for every learning style
and skill level. Whether you're a seasoned pro or just
getting started, it will help you get the most out of
CorelDRAW Graphics Suite.

New! Support for UltraHD 4K displays: An updated
interface and support for 4K monitors means that you
can comfortably view CorelDRAW and Corel PHOTO-
PAINT on even the most high-definition monitors,
including UltraHD. This allows you to edit photos at their
native resolution and see the subtlest details in the
image. And with more pixels at your disposal, you can
open several windows side-by-side for an efficient
workflow.

New! Advanced multi-monitor support: Support for
Per-Monitor Ul scaling and improvements to multi-
monitor support allow graphics professionals to take
advantage of the sharpness and fidelity of new High-DPI
monitors and laptops while still using lower-DPI
monitors to maximize design space (requires supported
hardware and Windows 8.1 or later). This ensures that
Ul elements scale properly and appear crisp and legible
on screens of all resolutions. For example, you can drag a
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document out of the application window and place it
within a second screen, dedicating one monitor to a
drawing or image and the other to frequently used
dockers and toolbars.

New! Windows 10 support: Thanks to our relentless
pursuit of delivering the highest quality user experience,
CorelDRAW Graphics Suite X8 is fully compliant with and
certified for Windows 10. Corel delivers the same
reliability and performance that users have come to
expect when working on the world’s most popular
operating system.

New! Product Details page: The new Product Details
page in the Welcome screen is your one-stop source for
the latest on the suite and your user account. It provides
important information about your product or
subscription, account status, product updates, and the
new Upgrade Program.
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Craft

The high-caliber, intuitive features of CorelDRAW Graphics
Suite X8 help graphics professionals maximize their
creativity. From the enhanced Knife tool for precisely and
intuitively splitting objects to a range of new image-
editing additions to Corel PHOTO-PAINT, you can craft
designs and refine photos with confidence and dexterity.

New! Font list box: Finding the right font for your
project just got a lot easier in CorelDRAW and

Corel PHOTO-PAINT. Using the new Font list box, you can
quickly view, filter, and find the specific font you need.
You can also now sort fonts based on weight, width,
supported scripts, and more. Font-searching capabilities
have also been enhanced, allowing you to use keywords
to locate fonts. In addition, any folders or font
collections added to Corel Font Manager are accessible
from the Font list box in CorelDRAW and Corel PHOTO-
PAINT, allowing you to use fonts that are not installed in
your drawings and documents.

: m@"" SWEETAHARMOS

The Font list box helps you quickly find the perfect font.




New! Hiding and displaying objects: Core|DRAW X8
lets you hide objects and groups of objects so that only
the sections you want or need to see in a project are
displayed. When working with complex designs, the
ability to hide a particular element in your drawing can
be a great time-saver. It ensures that you don't
inadvertently select and edit an object that you hadn’t
intended to work on, and it lets you experiment with
your designs more easily.

Object Manager »
P 1
BT i
B (] Page1
@ @& ol Guides
B @4 alll Layer1
# Curve
# Curve
# Curve
# Curve F
o
~ Curve
~ Curve
# Curve

sbruey palgo g1

You can hide individual objects or groups of objects
on a layer without hiding the entire layer.

Enhanced! Knife tool: With the enhanced Knife tool,
you can split vector objects, text and bitmaps along
straight, freehand or Bézier lines. You can create a gap
between the split objects or have them overlap. You can
also choose whether to convert outlines into curve
objects that can be manipulated or keep them as
outlines. And if you're unsure, CoreIDRAW can eliminate
any guesswork by automatically choosing the option
that best preserves outline appearance.

The enhanced Knife tool lets you split vector objects, text,
and bitmaps along any path so you can work faster.

(’) Give it a try

Splitting objects with the Knife tool

1 In CorelDRAW, click File » New.

2 Create a couple of shapes using the Ellipse tool
(press F7) or the Rectangle tool (press F6), and
click colors on the color palette to apply fills to the
shapes.

3 In the toolbox, open the Crop tools flyout, and click
the Knife tool §.

4 On the property bar, choose a split mode.

-Poi i -+
You can choose 2-Point Line / Freehand * |
or Bézier & mode.

5 On the property bar, choose an outline option.
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You can choose to convert lines to curves, keep
them as outlines when splitting objects, or let
CorelDRAW choose the option that best preserves
the outline appearance.

You can create a gap or an overlap between the
new objects by choosing an option from the Cut
span list box on the property bar. You can set the
size of the gap or the overlap in the Width box.
You can close the paths that result from splitting an

object by clicking the Auto-close on cut button m:'J

6 Drag across the objects to split them.

New! Selecting adjacent nodes: CorelDRAW X8
offers enhanced node selection that simplifies working
with complex shapes. You can now select adjacent nodes
on curves by using the Shape tool while holding down
Shift. You can also change the direction in which the
nodes are selected.

You can select several adjacent nodes (left), and you can
change the direction in which the nodes are selected (right).

New! Copying curve segments: Another new time-
saving enhancement in CorelDRAW X8 is ability to copy or
cut a specific part of a curve segment. You can then paste it

Reviewer's Guide [ 18]

as an object, making it easy to create new adjacent shapes
with similar contours.

You can copy, paste, or duplicate pieces of existing curves,
allowing you to reuse curve segments in your projects.

New! Drop shadows with Gaussian Blur
feathering: Drop shadows are a great way to enhance

elements in your designs. In CorelDRAW X8, you can
create more realistic drop shadows that have natural-
looking feathered edges in an instant thanks to the
Feathering direction button on the property bar.

You can adjust feathering of drop shadow edges.



New! Real-Time Stylus (RTS) support: You can use
your RTS-compatible pen tablet or device, including
Microsoft Surface Pro 4 and Surface Book, to capture

3 Enable the Real-Time Stylus option.

When you use a pressure-sensitive stylus or pen

. . o tablet, the amount of pressure that you apply
whatever inspires you on the fly. In addition to existing _
. controls the width of your strokes. Each person uses
support of Wacom tablets, support for the Windows _ _
: . . a different pressure level in a stroke, and you can
Real-Time Stylus delivers truly responsive pressure
. . . set CoreDRAW to match your stroke strength by
sensitivity and tilt and gives you full control of your

brushstrokes in CorelDRAW and Corel PHOTO-PAINT.
What's more, there’s no stylus driver to install, so you

specifying pen settings.
Proper pen settings are particularly useful if you

have a light touch. If a light stroke leaves no trace,

can get to work right away.

adjusting pen settings can increase sensitivity for
specific tools.

4 Using your stylus or digital pen, apply at least three
strokes in the window in the Pen Settings page,
building from the lowest to the highest pressure.

5 In the toolbox, click the Artistic Media Pressure
tool (b and apply a few brushstrokes in the
drawing window.

You can also use the pressure of your pressure-

sensitive pen with Eraser tool a Smear tool E}»,
Twirl tool @), Attract tool [}:2, Repel tool [{>,

Roughen tool '§', or Smudge tool ).
You can use your RTS-compatible device

to control your brushstrokes.

New! Healing Clone tool: It's easier than ever to

(’) Give it a try ensure that your photo subjects always look their best

thanks to the new Healing Clone tool. It discreetly

Using an RTS-compatible stylus with removes unwanted spots and imperfections from an
CorelDRAW X8 image by painting with sampled texture and matching it
1 In CorelDRAW X8, click Tools » Options. to the color of the area that you're retouching. In a few

clicks, you can seamlessly repair and blend a blemish or

2 In the Global list of categories, click Pen Settings. .
scar into the rest of the photo.
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The Healing Clone tool helps you refine your

photos by painting with sampled texture.

Give it a try

Fixing imperfections with the
Healing Clone tool

In Corel PHOTO-PAINT, open an image.

In the toolbox, open the Touch-up tools flyout, and
click the Healing Clone tool f&.

You can also activate the Healing Clone tool with a
keyboard shortcut by pressing 0.

You can adjust settings for the Healing Clone tool

to work with more precision. On the property bar,
you can set the nib’s size or shape, and specify the
brushstroke’s transparency or feathering.

You can also adjust the nib size on fly by holding
down Shift and dragging.

Set a source point by clicking an image area that
contains the texture that you want to use to
retouch an unwanted area.
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The source point brush is marked by a crosshair.
You can reset the source point by right-clicking any
area of the image.

4 As you move the cursor away from the source
point, you'll see the target brush, which applies the
sampled texture and matches it to the color of the
surrounding area.

5 Drag across the area that you want to cover.

The source point brush moves relative to the target
brush as you drag across the image. You can use
the same source point for subsequent brushstroke
by holding down Shift+Alt as you drag.

Enhanced! Correcting perspective distortions: With
the enhanced Straighten Image dialog box in CorelDRAW
and Corel PHOTO-PAINT, you can correct perspective
distortions in photos that have straight lines and flat
surfaces. Now in a few clicks, you can easily fix photos of
buildings, landmarks, or objects that appear in the wrong
perspective or that were taken from an angle other than
directly in front.

You can quickly correct perspective distortions in photos.



Give it a try

()

1 In Corel PHOTO-PAINT, open an image.

Correcting perspective distortion

2 Click Adjust » Straighten Image.

3 In the Straighten Image dialog box, move the
Vertical Perspective slider to the left until the
image appears as if it had been captured straight
on.

4 To crop and resample the corrected image to its
original size, enable the Crop check box, and then
enable the Crop and resample to original size
check box.

5 Click OK.

New! Gaussian Blur lens: The Gaussian Blur special
effect in Corel PHOTO-PAINT is now available as a lens,
so you can blur images without overwriting the original
image. When you create a lens, the changes you make
are non-destructive, so any edits are displayed on the
screen through the lens rather than applied to the image
pixels. The lens is created as a separate object on a layer
above the image background so you can edit the lens
and the background image separately, maintaining the
original’s data and quality.

You can blur an image without overwriting it.

Give it a try
Applying a Gaussian Blur lens

In Corel PHOTO-PAINT, open an image.

Click Object » Create » New Lens.

You can also create a lens by clicking the New Lens
button in the Object Manager docker. If the
Object Manager docker is not open, click Window
» Dockers » Object Manager.

In the New Lens dialog box, choose Gaussian Blur,
and click OK.

In the Gaussian Blur dialog box, experiment with
the Radius slider.

As you move the slider to the right, you increase the
blurring of the focus of the image according to
Gaussian distribution, which spreads the pixel
information outward using bell-shaped curves to
produce a hazy effect.
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Personalize

Every creative professional has a way of working that's as
unique as the designs that they create. With that in
mind, CorelDRAW Graphics Suite X8 encourages you to
work in whatever way best suits you and your projects.
Customizable icon sizes and Ul border colors, a new
font-management application, and the ability to expand
your collection of creative tools from within the suite
ensure that you can adapt your workspace to your
needs.

New! Corel Font Manager: When the number of fonts
on your system become less of a benefit and more of a
hassle, Corel Font Manager is the answer. It lets you
easily handle, organize, and explore your typeface and
font collections by giving you the tools to control every
aspect of your typography workflow. Whether you want
to find fonts for your projects, organize fonts for easy
access, or manage unneeded fonts, Corel Font Manager
has the tools you need. It lets you access online fonts
from the Content Exchange, which you can install or
download to use later. You can browse and search online
and local fonts, preview font glyph sets, add custom font
collections, and more.

When you add folders and create collections, all your
fonts, including ones that aren’t installed, become
accessible from the Font list box in CorelDRAW and
Corel PHOTO-PAINT. This means that you can use fonts
that are not installed in your drawings and documents.
In addition, any collections that you create appear as
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font filters in the Font list box of the main applications,
so you can filter fonts to show only the fonts included in
specific collections.
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The new Corel Font Manager simplifies exploring, organizing,
and managing your typeface and font collections.

(!) Give it a try

Searching for a font

1 Click the Application launcher button [£] on the
standard toolbar, and then click Corel Font
Manager.

Corel Font Manager, a standalone font-
management application, opens.

2 In Corel Font Manager, click Content Exchange in
the Libraries pane to display online fonts that are
provided by Corel and are available for download.

3 Type Humanst in the Search box.

Fonts that match this search term appear in the
Preview pane.



New! Fully customizable Ul: CorelDRAW Graphics
Suite X8 offers more Ul customization options than ever
before, allowing you to tailor your design space to create
a unique work environment. Newly redesigned icons
permit scaling up to 250%, and you can choose from a
variety of colors for the application background by
choosing a theme.

You can fully customize your design space to your needs.

New! Customizing desktop color: Core[DRAW
Graphics Suite X8 offers flexible desktop color scheme
options. You can change the color of the area
surrounding the drawing page in CorelDRAW or the
image in Corel PHOTO-PAINT to set up the optimal
environment for each project, reduce the overall
workspace contrast, or increase the legibility of design
elements.

New! Customizing window border color: You can
customize the color of window borders in CorelDRAW
and Corel PHOTO-PAINT to match your personal

preference. If you use both applications simultaneously,
you can set different border colors for each, which lets
you quickly identify them when switching programs.

(,) Give it a try

Customizing the Ul

1 Click Tools » Options.

2 In the Workspace list of categories, click
Appearance.
3 In the Size area, move the slider to the right for

larger Ul items, and to the left for smaller Ul items.

The scaling level is relative to the scaling level of the
operating system. The default setting is 100%,
which means that Ul items in the application
appear the same size as similar Ul items in the
operating system. Scaling by 200% makes the
application Ul items appear twice as large as the Ul
items of the operating system.

4 In the Color area, choose an option from the
Theme list box.

To make the workspace lighter or darker, you can
choose one of the following themes: Light,
Medium, or Dark.

5 To change the border color of the application
window and dialog boxes, open the Window
border color picker, and choose a color.

6 To change the color of the area surrounding the
drawing page, open the Desktop color picker, and
choose a color.
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New! Get More docker: You can expand your
collection of creative tools by downloading applications,
plug-ins, and extensions directly from within CorelDRAW
and Corel PHOTO-PAINT. You can download your free
license of Corel Website Creator, purchase AfterShot Pro
for the ultimate RAW workflow, experience Corel
ParticleShop for amazing bitmap effects, and more.

Get Mare

H ?
Apps & Plug-ins [Extensions; CONNECT 0 L]

\/ = Border and Grommet |

Prepare banners for print and post ]
processing quickly and efficiently. 8

FREEE  Fe

Prep and Stretch

Prepare art for printing on carvas and
stretching onto frame.

™
/- FREEQ o

File Converter

. |
o Easily conven files to 14 popular file
i y pop:
[ 1] |. formats.

FREE[E  ree

Calendar Wizard

Generate high-quality calendars using
over 30 layouts and 500 parameters.

FREEE e

Color Chart Creator

Create color charts from stock and
EER custom color palettes.

FReclll e

The Get More docker lets you expand your collection of creative
tools directly from within CoreIDRAW Graphics Suite X8.
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(!) Give it a try

Downloading apps and extensions from
within CorelDRAW or Corel PHOTO-PAINT

Note: You must be online and signed in to your
corel.com account to download apps from within
the main applications.

1 On the standard toolbar, click the Search Content
button H to open the Get More docker.

2 Click Apps & Plug-ins, and click Corel Website
Creator.

This application offers a fast and easy way to
design, build, and manage websites.

3 Click Download.

4 Click Extensions, and click Border and Grommet
and Prep and Stretch.

5 Click Download.

New! Border and Grommet dialog box:
CorelDRAW X8 accelerates the workflow of production
professionals with the Border and Grommet dialog box,
which simplifies preparing banner designs for printing. It
has intuitive controls for precisely creating the perfect
border for the job, whether it's stretching or mirroring
the document edges or defining a color. This feature also
simplifies adding grommets, which are rings or edge
strips inserted into holes through thin material used to
insert ropes and properly hang a banner. The Border and
Grommet dialog box also gives you the flexibility to



create a banner from entire active page or just selected
objects.

o o = e

The new Border and Grommet dialog box lets you create a
banner from a page or from selected objects on a page.

New! Prep and Stretch docker: One of the best ways
to show off a great photo is to print it on canvas. With
the Prep and Stretch docker in Corel PHOTO-PAINT X8,
you can prepare your photos and images for canvas
printing in three easy steps. By resizing, fine-tuning, and
stretching the image, you can achieve the perfect
composition for your wall art.

You can easily turn an image into a piece of wall art.

Enhanced! Image opening options: So you can set up
your workspace in the way that best suits your style, Corel
PHOTO-PAINT offers options for how your photos open. You
can now have a number of documents visible simultaneously
in floating windows. Or if you want to focus on one image at
a time, you can open files in a the default tabbed view.

New! Community website for developers: With
support from the new Developer Community site, you can
create your own automation tools. There's a variety of useful
resources, including in-depth programming articles and code
samples, which can help you automate tasks with macros
and create custom features. And when you have questions,
you can turn to a community forum, knowledge base, or the
FAQ page.

For information, visit www.community.coreldraw.comy/sdk.
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CorelDRAW® Graphics Suite user favorites

CorelDRAW Graphics Suite users continue to enjoy many
of the following features that have been cornerstones of
the suite for years.

Special characters and glyphs: The Insert Character
docker presents all characters and glyphs associated with
a selected font, making it easy to find these items and
then insert them in your documents. Available in both
CorelDRAW X8 and Corel PHOTO-PAINT X8, the docker
includes a filtering option that lets you display only the
character subsets that you want. For example, you can
choose to display only the Cyrillic characters for a selected
font.
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You can quickly find a font’s available characters
and glyphs by using the Insert Character docker.
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Font Playground: In both CorelDRAW X8 and Corel
PHOTO-PAINT X8, the Font Playground docker offers an
easy way to browse, experiment with, and choose the
perfect font. You can easily add sample text to view its
appearance in different fonts, and a handy Zoom slider
lets you quickly adjust the size of sample text. With a
single click, you can also choose whether the sample text
appears as a single line, multiple lines, or a cascading
series of increased sizes. The Font Playground also
provides access to advanced features within OpenType
fonts. If a text sample uses an OpenType font, and the
selected characters have OpenType alternates, simply
select the text to display the Interactive OpenType arrow
and then choose which features to apply.
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With the Font Playground, you can easily find the perfect font
by comparing and adjusting a variety of text samples.



Font embedding: You can embed fonts when you save
CorelDRAW documents so that recipients can view, print,
and edit the document exactly as designed. This is
especially useful when sending a CorelDRAW file to a print
shop, ensuring that the document can be viewed and
printed accurately.

CorelDRAW X8 respects any restrictions encoded with each
font, so a font must support embedding to be saved with the
document. While some fonts cannot be embedded, most will

support embedding for either print and preview, or for editing.

OpenType support for Asian text: While working
with Asian text, you can use advanced OpenType
typography features, such as widths, forms, vertical
metrics, kana glyph alternatives, and vertical alternates
and rotation.
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You can access advanced OpenType features for Asian text.

Interactive OpenType: With the Interactive OpenType
feature enabled, CorelDRAW will suggest eligible
features contained in OpenType fonts that you can apply
to your selected text.

Fit text to path: Both CorelDRAW and Corel PHOTO-PAINT
let you add text along the path of an open object (for
example, a line) or a closed object (for example, a circle).
You can easily adjust the position of the text in relation to
the path.

Interactive frames: You can efficiently generate mock-
ups and preview layouts by using interactive placeholder
frames. You can drag content over a PowerClip frame, and
choose whether to add the content or replace existing
frame content. With PowerClip frames, you can specify
centering the content within the frame or scaling the
content to fit proportionally within the frame. Plus, you
can create text frames from any closed curve object, and
you can edit the frame to take on any shape imaginable.

Click here with
Text Tool to
add Paragraph text

The empty PowerClip feature helps you
visualize a layout before adding content.
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Workspace selection: The Welcome Screen includes a
Workspace tab, which lets you choose from a variety of
workspaces that were designed for different proficiency
levels and specific tasks. For example, there are Page
Layout and lllustration workspaces, a classic option for
longtime users, as well as a Lite option for new users.

Simple customization: The toolbox, docker space, and
property bars contain handy Quick Customize @
buttons, which will help you tailor the interface to suit
your workflow. Available in both CorelDRAW X8 and Corel
PHOTO-PAINT X8, these buttons offer a faster and more
convenient way to add dockers to your workspace, add or
remove tools from the toolbox, and add or remove items
from a property bar.

Property Bar # 0 v A X
Y ~ -] R +

| bd Preset

+ 1 Brush

+| B Sprayer

+ & Calligraphic

v # Pressure

¥ all Preset Stroke List

| A2 Freehand Smoathing
1 width
Bl Scale Stroke With Object
3% Bounding Box

Reset toolbar

Customize_.

The Quick Customize buttons make
workspace customization fast and easy.
Default and X6 Inspired workspaces: The default
workspaces for CorelDRAW X8 and Corel PHOTO-PAINT X8
offer an intuitive and efficient configuration of tools,
menus, status bar, property bars, and dialog boxes. Plus,
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the classic X6 Inspired workspaces are still included for
longtime users who may prefer the suite’s legacy
appearance. There are also Adobe lllustrator and Adobe
Photoshop workspaces, which will help new users get up
to speed within a familiar environment.

Fountain fills: You can create elliptical and rectangular
fountain fills, apply transparency to individual color
nodes within a fountain fill, repeat a fill within a filled
object, adjust a fill's angle of rotation, and smooth the
blend transition of a fountain fill.

With CorelDRAW X8, you can apply and adjust fountain
fills more quickly, accurately, and creatively by using the
interactive controls in the Object Properties docker or the
Edit Fill dialog box. In Corel PHOTO-PAINT X8, the Edit Fill
dialog box provides quick access to all available controls
for adjusting fountain fills.
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The Object Properties docker provides interactive
controls for applying and adjusting fountain fills.



QR codes: With CorelDRAW X8, you can create unique,
artistic, and scalable QR codes by adding text, colors,
and images. Popular in consumer advertising and
packaging, QR codes give smartphone users quick access
to a brand’s website, which can offer additional product
information. The Object Properties docker makes it easy
to customize a QR code, and you can create an object
style that saves a fixed appearance for the QR code to
enable quick and easy reuse.

You can change the shape, outline width, color, and fill
type of the QR code pixels, change the background color
and fill type, and more. You can also choose which
information to include in the QR code, such as URL,
email address, phone number, SMS, Contact, Calendar
event, and Geo location. There’s also a Validate option,
which analyzes the QR code to ensure it can be read by
QR code readers, smartphones, and scanners.
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CorelDRAW X8 provides extensive
options for the creation of QR codes.

Smoothing objects: The Smooth tool lets you remove
jagged edges and reduce nodes in curve objects. You can
control the smoothing effect by varying the size of the
brush nib, the speed at which the effect is applied, and
by using the pressure of your digital pen or stylus.

The Smooth tool helps you to remove jagged
edges and reduce nodes in curve objects.

Liquid tools: Corel PHOTO-PAINT X8 has four pressure-
sensitive Liquid tools — Smear, Attract, Repel, and Twirl —
that offer creative options for retouching photos. You can
use these tools to reshape specific image areas to produce
unique artistic effects. Each tool responds to the pressure
of your digital pen or stylus, and provides options that help
you control the intensity of the effect.

With the Liquid Smear tool, you can push pixels around
an image area to produce distortion effects. The Liquid
Twirl tool produces twirl effects from image areas. The
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Liquid Attract and Liquid Repel tools pull pixels toward
or push pixels away from an image area.
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Corel PHOTO-PAINT X8 includes pressure-sensitive Liquid
tools that provide creative options for retouching photos.

Interactive brushstroke transparency and
feathering: With Corel PHOTO-PAINT X8, you can use

modifier keys to interactively adjust the transparency and
feathering of brushstrokes. This lets you apply transparency
and feathering on the fly, and works with the Eraser, Red-eye
removal, Clone, Touch-up brush, Paint, Effect, Image Sprayer,
Undo brush, and Replace color brush tools.

You can apply brushstroke transparency
and feathering interactively.
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Special effects: Corel PHOTO-PAINT X8 has a variety of
camera effects, such as Bokeh blur, Colorize, Sepia
Toning, and Time Machine to help you recreate historic
photographic styles and give your images unique visual
appearances.

With the Bokeh blur effect, you can define an area of
focus and leave the rest of the image out of focus. You
can create a duotone image by using the Colorize effect
to replace all colors in an image with a single hue. The
Sepia Toning effect simulates a photo taken with sepia
film, which is similar to grayscale except with brown
tones. And with the Time Machine, you can choose from
seven historic photography styles ranging from 1839 to
the 1960s.

Corel PHOTO-PAINT X8 provides camera effects to
help you create images with unique visual appearances.

Content Exchange: The Content Exchange is an online
repository that integrates with Corel CONNECT and the
suite’s applications, making it quick and effortless to
access and share clipart, photos, fonts, frames, vector
and bitmap patterns, and image lists with a community
of other users.



Search capability in Corel CONNECT: You can quickly
leverage content assets from online sources by typing a
web address in the Corel CONNECT search toolbar. You
can also search the Content Exchange, iStock, Fotolia,
Flickr, Microsoft OneDrive, or a folder path for local or
network content.

Color harmonies: You can group a document’s color
styles into a color harmony, which makes it quick and
easy to produce iterative designs with varying color
schemes. A color harmony combines two or more color
styles into a hue-based relationship. You can then modify
them collectively, altering color composition of your
artwork in one step.

In addition, you can also create a special type of color
harmony called a gradient, which consists of one master
color style and a number of varying shades of that color.
When you alter the master color, the gradient colors
automatically adjust to the same degree that the master
color was altered. This is especially useful when
outputting multiple color variations of the same design.

Color harmonies make it easy to
change combinations of colors.

Smart Carver™: In Corel PHOTO-PAINT, you can use the
Smart Carver to easily remove unwanted areas from a
photo and simultaneously adjust the photo’s aspect
ratio. The versatile Object Removal brush lets you choose
to paint either the area of the photo you want to
preserve or the area that you want to remove. When
adjusting aspect ratio, the Smart Carving presets let you
contract or expand a photo’s background vertically and
horizontally without distorting the photo.

The Smart Carver makes it easy to remove unwanted
areas and adjust the photo’s aspect ratio.

Create clip mask: With clip masks in Corel PHOTO-PAINT,
you can adjust the properties of a group of objects in a
way that is non-destructive to the individual objects within
the group. For example, you can adjust transparency levels
for the whole group without altering the pixels of the
individual objects.
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Corel PowerTRACE: This utility lets you quickly and
accurately convert bitmaps into editable and scalable
vector images, which is especially useful for design work
that's based on existing artwork. PowerTRACE generates a
color palette, which lets you instantly edit, merge, or
delete specific colors used by the original artwork.

You can use PowerTRACE to convert bitmaps to vectors.

Cutout Lab: This intuitive utility simplifies the process of
accurately cutting out specific areas of an image. For
example, you might want to extract a specific part of a
photo into its own object.

Image Adjustment Lab: This time-saver makes it easy
to correct common color balance and tone problems
from a single dialog box.

Smart Fill tool: This convenient tool detects the edges
of an area and creates a closed path so that the area can
be filled. By using the Smart Fill tool, you can fill

practically anything. For example, if you draw a freehand
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line that crosses over itself to create loops, the Smart Fill
tool will detect the edges of the loops and fill them.

The Smart Fill tool helps you fill enclosed areas.

Interactive Fill tool: You can add uniform, linear, elliptical,
conical, rectangular, two-color pattern, vector pattern,
bitmap pattern, texture, and PostScript fills by using the
Interactive Fill tool.

The Interactive Fill tool helps you apply bitmap pattern (top row),
fountain, vector pattern (bottom row), and two-color fills.



Mesh Fill tool: You can create unique effects by filling
an object with a mesh fill. For example, you can create
smooth color transitions in any direction without having
to create blends or contours. The Mesh Fill tool lets you
specify the grid’s intersecting points as well as the
number of columns and rows in the grid.

Dimension tools: CorelDRAW includes several
dimension tools that make it easy to detail precise
measurements in your design. For example, dimension
lines can be used to display the size of objects, or the
distance or angle between objects. You can choose from
angular, parallel, horizontal, vertical, or segment
dimension tools.

Fillet / Scallop / Chamfer docker: This docker makes
it easy to shape the corners of curve objects. Filleting
produces a rounded corner; scalloping rounds and
inverts the corner to create a notch; and chamfering
bevels the corner so that it appears flat.

"

You can fillet, chamfer, or scallop the corners of objects.

Contour tool: This tool helps you create interesting 3D
effects and cuttable outlines for output to devices, such
as plotters, engraving machines, and vinyl cutters. When
you contour an object, you add evenly spaced concentric
shapes that progress to the inside or the outside of the
object’s borders.

The Contour tool helps you create 3D effects.

Document palette: When you start a new CorelDRAW
document, a custom color palette is automatically
created. The palette is then saved with your file, which
gives you quick access to the project’s specific colors in
the future.

Artistic Media: The Artistic Media tool gives you access
to the Brush, Sprayer, Calligraphic, and Pressure tools.
With each of these tools, you can create pressure-
sensitive lines which vary in thickness.

Color Proof Settings docker: This docker helps you
efficiently prepare artwork for various output devices.
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You can save presets, choose from a list of output
devices to preview your output, export soft proofs for
client approval, and print hard proofs from the docker.
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You can prepare artwork for various output
devices with the Color Proof Settings docker.

Outline Position: With CoreIDRAW X8, the Outline
Position options help you create objects with more
precise sizes. You can specify whether an outline is
positioned inside the object, outside the object, or an
equal combination of both. By positioning an outline
inside an object, you can more easily create layouts with
specific sizes because the outline will be rendered within
the object’s original dimensions.
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You can specify an outline’s position so that it appears
outside (left), inside (right), or centered (middle).
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Planar Mask tool You can use the Planar Mask tool in
Corel PHOTO-PAINT X8 to define a feathered editable
area along parallel lines. When combined with a blur
effect, you can simulate depth of field, giving focus to a
particular object while blurring areas outside the planar
mask. You can modify the effect of the planar mask by
moving or rotating the lines, and you can also use mask
modes with the Planar Mask tool.
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The Planar Mask tool lets you define a
feathered editable area along parallel lines.
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